MECANICA ORBITAL Y VEHICULOS ESPACIALES

Practica 1 de STK: Introduccion a STK. Conceptos basicos.
Visualizacion de orbitas.

NOMBRE DEL ALUMNO:

En estas practicas se pretende introducir de forma visual la teoria basica acerca de los
satélites, sus Orbitas, y los procedimientos de estudio de la geometria orbital, asi como otros

pardmetros importantes para una mision geocéntrica o planetocéntrica (tales como cobertura y
visibilidad).

Para ello se empleard el STK (Satellite Tool Kit), un software comercial (y bastante caro en
su version profesional) empleado para analizar en un entorno grafico todos los pardmetros de una
mision espacial. La version usada serd (evidentemente) la gratuita, que permite visualizacion en 2D
y 3D y diversas funciones avanzadas. Dicha version es descargable por los alumnos.

La primera practica sera de introduccion al entorno STK y a las diferentes posibilidades que
éste ofrece; se estudiaran las orbitas de satélites con ciertos elementos orbitales y como éstas varian
al cambiar los elementos. También se introduciran algunos conceptos basicos de STK como la
eleccion de sistemas de referencia y de cuerpo central, proyecciones cartograficas, etc...

Se pide rellenar el boletin de practicas con ciertos resultados cualitativos y/o analiticos (se
recomienda usar el formulario al final del boletin y si se desea, MATLAB) u obtenidos mediante
STK, realizando los pasos indicados en el boletin de précticas. Si bien no se corregiran dichos
apartados y se considerard la practica superada con la asistencia y posterior entrega del boletin, es
muy recomendable pensar estos apartados ya que muchos de ellos son bésicos. Al final se indican
unos apartados opcionales que se pueden realizar para aprender mas sobre STK.

NOTA IMPORTANTE: Todas las acciones hay que aplicarlas "Apply" antes de aceptarlas
HOk"'

NOTA IMPORTANTE 2: Si las practicas se realizan en el Centro de Calculo, es
recomendable desactivar el acceso a internet, lo que mejora el rendimiento de los ordenadores. Para
ello, antes de hacer nada, ir a la pestafia de Edit -> Preferences -> Online y desmarcar “Allow
online operations”. En el ordenador personal del alumno si puede ser interesante dejar la opcion
marcada ya que carga mapas online, actualiza los elementos orbitales de satélites reales, etc...

1. El escenario.

Un escenario "Scenario" es el elemento basico donde transcurre la simulacion de una
mision, y donde se almacenan todos los elementos de los que dicha misién se compone.

Para empezar, se creard uno con "File" = "New..." = "Ok". Aparecera en la columna



izquierda, que es una lista de todos los objetos "Object Browser" de los que consta la simulacion. Se
renombrara por ejemplo como "Practical Iniciales del Nombre del Alumno" haciendo clic derecho
sobre "Scenariol" y eligiendo "Rename" (por ejemplo, "Practical RVV" en el paradojico caso de
que el profesor fuera su propio alumno). Maximizar el tamafio de los graficos y cerrar "Timeline
View 1". Luego, haciendo doble clic en el escenario, se fijan las coordenadas temporales para la
simulacion "Analysis Period". Se simulara desde "Start" = "1 Nov" del afo actual hasta "Stop" =
"30 Nov" del afio actual, ambos dias al mediodia.
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Figura 1: Periodo de simulacion y época.

Obsérvese que las unidades del tiempo por defecto son "UTCG" (Gregorian UTC) pero se
puede cambiar a dias julianos "JDate", haciendo click en "Units" = "DateFormat" - "Julian Date
(JDate)".

1. (Qué dia Juliano es el 1 de Noviembre del afo actual a las 12:00 UT?

Una vez contestada la cuestion anterior, volver a poner las unidades por defecto "UTCG"
(Gregorian UTC).

Para guardar un escenario y todos los objetos en ¢l contenidos, usar "File" = "Save" o
"Save As...". Conviene crear un directorio puesto que cada objeto de un escenario se guarda como
un pequeio archivo; luego dicho directorio se puede comprimir para guardar todo con mas
facilidad.



2. Ventana de visualizacion grafica 2D.

Obsérvese que existe una ventana de graficos 2D y otra 3D que se pueden seleccionar en la
parte inferior izquierda de la pantalla.

Se empezara con la visualizacion bidimensional. Pinchar en la ventana 2D y pulsar el boton

"Properties” —J. En dicha ventana de propiedades se pueden cambiar muchas caracteristicas de la
visualizacion.

Para empezar se va a observar el movimiento del Sol; para ello, en primer lugar, ir al
apartado de "Lighting" y seleccionar "Show Outline" en "Sunlight/Penumbra" dentro de
"Sunlight/Penumbra/Umbra Transitions"; también "Show" en "Subsolar Point" (el punto subsolar
es aquel punto de la Tierra en donde el Sol se encuentra justo en su cénit), poniéndolo de color rojo.
Volver a la ventana 2D y arrancar la simulacion pulsando el boton de "Play" »P; se define el
terminador como la linea de separacion entre la parte iluminada y la parte en sombra de un cuerpo
(planeta, satélite) cualquiera, es decir, la linea de separacion o frontera entre el dia y la noche.
Obsérvese como aparece dicho "terminador”. Las flechas arriba y abajo ¥ & sirven para
incrementar o reducir la velocidad de simulacion. El botdn rojo hacia atras M sirve para reinicializar
la simulacién (conviene pulsarlo cuando se hacen cambios en los parametros de simulacion). La
barra a la derecha del instante de tiempo de simulacion "Current Scenario Time" sirve para situarse
en un punto dado de la simulacion.

(NOTA: Si no se ve una cruz marcando el punto subsolar, volver a la anterior ventana y cambiar el
marcador (marker) del punto subsolar; este problema aparece en algunos ordenadores del centro de
calculo. De la misma forma, en ciertos ordenadores del CDC por alguna razén no se aprecia
diferencia entre la parte oscura e iluminada de la Tierra.)

Obsérvese que al desplazar el cursor por el mapa 2D en la parte inferior de la pantalla
aparece la latitud/longitud del punto donde se encuentra el cursor. Observar también que se puede
hacer zoom marcando el botéon "Zoom In" ® y luego seleccionando un recuadro en el mapa.
Igualmente se puede hacer zoom hacia atras con "Zoom Out" &. Por ejemplo se puede facilmente
determinar las zonas de la Tierra que estan en Noche o Dia eternos, para un dia cualquiera del afo.

Volver a la ventana de propiedades de 2D y pasar ahora al apartado "Projection". Ahi se
puede seleccionar el tipo de proyeccion. Por ejemplo elegir "Projection Format" - "Type"
—>"Mercator" y observar como cambia el mapa. Elegir ahora una proyeccion estereografica
"Stereographic" centrada en el polo norte (se selecciona en las propiedades de la derecha, arriba, en
concreto poner una latitud de 90°), "Center" = "Lat:" = "90 deg" y observar como se mueve el
terminador del dia y la noche (en ese tipo de proyeccion se pierde el "sombreo" de la noche y el
dia). Probar también la azimutal equidistante "Azimuthal Equidistant", centrada igualmente en el
polo norte. Volver a la proyeccion estandar "Equidistant Cylindrical" (equidistante cilindrica).

3. Ventana de visualizacion grafica 3D.

Se pasa ahora a trabajar con la ventana 3D. Seleccionarla y probar como el movimiento del
ratoén con el botén izquierdo pulsado o el boton derecho pulsado, alteran la visualizacion; si se deja
pulsado "Shift", "Alt" o "Ctrl" también cambia el efecto de mover el raton. Obsérvese que el
"terminador" y la zona iluminada/oscura de la Tierra aparecen automaticamente.



{%} - ¥ @ v , .
Probar los botones * eSS de la ventana gréafica 3D. El ojo con una casa,
con una N o con una flecha hacia abajo ofrecen vistas predeterminadas. El ojo con una caja permite
almacenar puntos de vista.

El boton mas interesante es el ojo con una flecha. Este permite cambiar a ciertos puntos de
vista. Una de las cosas que permite es cambiar de sistema de referencia del geocéntrico inercial al
geocéntrico de ejes fijos a Tierra "Earth Fixed Axes". Observar la diferencia.
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Figura 2: Cambio de sistema de referencia.

4. Anadir satélites.

Ahora se van a estudiar satélites en orbita geocéntrica. Eliminar antes las opciones 3D antes
elegidas.

Los satélites se anaden con "Insert Default Object” @+ > "Satellite” & > "Insert"".

En primer lugar se afiadird un satélite, al que se le llamara "LEO1" (click con botén derecho
sobre "Satellitel" = "Rename") y se elegiran en las propiedades del satélite (doble click sobre
"LEO1"), opcion "Basic" = "Orbit", los siguientes elementos orbitales clasicos "Coord Type" =
"Classical": "a" = "Semimajor Axis = 6800 km", "e" = "Eccentricity = 0.005", "i" = "Inclination
= 30 deg", "w" > "Argument of Perigee = 0 deg", "Q" > "RAAN = -85 deg", "@" > "True
Anomaly = 0 deg". Estos parametros definen un satélite en orbita baja (unos 400km de altitud), de
oOrbita casi circular. Obsérvese como aparecen las trazas (huella sobre la superficie de la Tierra) del
satélite en el mapa 2D, para los 30 dias de simulacion. En las propiedades del satélite, en "Basic" =
"Orbit", se pueden cambiar los elementos para ver propiedades tal como el periodo de la orbita



cambiando " Semimajor Axis" = "Period".

2. Calcular la altitud de perigeo y apogeo del satélite. ;Cudl es su periodo? (Recomendacion: para
estos calculos observar que STK permite convertir elementos orbitales, por ejemplo el semieje
mayor, a periodo, altitud de perigeo, etc...). ;Qué sucede si cambiamos "a = 4000 km" y por qué?

(Coémo se modifica la traza si aumentamos o disminuimos "Q"?

Obsérvese que eligiendo "Coord Type" -> "Cartesian" se realiza una conversion a
coordenadas cartesianas de los elementos orbitales, dentro del apartado de propiedades del satélite.

Usar ahora "Insert Object" % - "Satellite" = "From Standard Object Database" -
"Insert..." para insertar el telescopio espacial Hubble. Buscarlo en "Local" = "Common Name" =
"Hubble" = "Insert". Una vez el Hubble se ha afiadido, animar la simulacion y contemplarla en 2D
y en 3D.

3. (Por qué las trazas 2D de las 6rbitas no son curvas cerradas? Obsérvese que la traza de "LEO1"
da un "salto" (en longitud) al cruzar el Ecuador de Sur a Norte con respecto a la orbita anterior. (Es
posible escribir una ecuacidon que calcule la magnitud de dicho salto? Comprobarla para "LEO1".
Pista: Recordar el retraso nodal, explicado en clase, debido a la rotacion de la Tierra.

(OBSERVACION: El siguiente parrafo puede causar bloqueo de los ordenadores de ultima
generacion del centro de céalculo. Si se bloquearan, serd necesario reiniciar y se perderia el trabajo
anterior, por lo que se recomienda salvar el escenario antes de proseguir.)

La visualizacion 3D ofrece opciones interesantes. Por ejemplo, para "ver lo que ve el satélite", ir a

la visualizacion 3D y elegir el icono con el ojo y la flecha L Elegir "View" = "From Position to
Position", "From Position" = "LEO" = "Apply", y rotar la vista. Obsérvese que en las propiedades
del satélite, "3D Graphics" = "Model", se puede elegir un "Model File" con un modelo grafico en
3D del satélite.



Una opcidn interesante para observar la variacion de la traza con los elementos orbitales es
el llamado “Orbit Designer”. Elegir "Insert Object" # - "Satellite" = “Orbit Wizard”. Observar
que aparece una ventana con la traza durante una revolucion. Elegir el “Orbit Designer” en el menu
desplegable titulado “Type”. Se observa que aparecen los seis elementos orbitales y un pequefio
indicador deslizable debajo de cada uno de ellos que permite cambiar su valor sin tener que
introducir nimeros. La gran ventaja de esta herramienta es que permite ver directamente el efecto
de cada elemento orbital sobre la traza para todo su rango de variacion.

4. Partir de un satélite base en 6Orbita baja (a=7000 km, e=0, i=30°, argumento del perigeo 0°,
RAAN 0° anomalia verdadera 0°). Resumir los efectos (por ejemplo con pequefios dibujos o
descripciones) visualmente observados para cada elemento sobre la traza (variar el elemento
orbital y luego devolverlo a su valor original).

e Efecto de a:

e Efecto de e (para apreciarlo mejor poner a=25000km e i=60°, luego devolverlos a los
valores originales):

e Efecto de i (hasta 90°):

e Efecto de i (mas de 90°):

e Efecto del argumento del perigeo (poner e=0.5, a=25000km e i=60° para poder apreciar
su efecto antes de variarlo, luego devolver los valores a los originales).

e Efecto del RAAN:

e Efecto de la anomalia verdadera:




Cerrar finalmente el “orbit designer” sin crear ningln satélite. Afiadir ahora los siguientes
satélites, eligiendo como se quiera los elementos orbitales no indicados.

A. Un satélite con orbita polar (inclinacion proxima, pero no exactamente igual, a 90
grados), aproximadamente circular y en oOrbita baja (altitud en torno a 1000 kilometros). Llamarlo
"POLAR".

B. Un satélite en orbita media (semieje mayor 22000 kilémetros, es decir, aproximadamente
casi cuatro veces el radio de la Tierra), aproximadamente circular, y que sobrevuele Europa en
alguna de sus pasadas. Llamarlo "MO1".

C. Un satélite con una oOrbita de alta excentricidad (por ejemplo, mayor de 0.5), argumento
del perigeo 90 grados, y semieje mayor en torno a los 30000 kilémetros. Llamarlo "HEO".

5. Observar las trazas 2D en comparacion con la orbita 3D. ;Por qué "POLAR", teniendo una
orbita circular (de velocidad uniforme) circula muy rapido sobre los polos? Pista: Pensar el espacio
real que ocupan los polos y el que ocupan en la proyeccion 2D.

(Por qué "HEO", teniendo una orbita directa (inclinacion menor de 90 grados) circula hacia el
Oeste (en las trazas 2D), es decir, aparenta ser retrégrada, en ciertos tramos de su orbita? Pista:
(En torno a qué punto de su orbita se produce este efecto? Observar el satélite en 3D en las
cercanias de dicho punto. ;Como es la velocidad del satélite en dicho punto comparada con la de
la Tierra?

5. Trazas repetidas

Permitir que se visualicen hasta 8 trazas de "MO1" (propiedades del satélite, "2D Graphics"
- "Pass" > "Passes" = "Show Pass From = "1 To 8" y marcar "Leading/Trailing" = "Ground
Track" = "Lead Type" > "All") y modificar ahora su semieje mayor disminuyéndolo de 500 en
500 kilometros. Observar el fendémeno que se produce en 20500 kilémetros.

6. (Es posible conseguir que las trazas de "MOI1" se repitan exactamente? Si es asi, ;con qué
semieje mayor proximo a 20500 kilometros y por qué? ;Cada cuantas oOrbitas se repite? Pista:
Modificar el periodo como elemento orbital, en vez del semieje mayor y recordar la respuesta al
apartado 3 (intentar que el retraso nodal sea una fraccion exacta de 2m).




Si se ha conseguido el apartado anterior, afiadir la ciudad de Madrid (Insert-> From Standard
Object Database->City) y modificar los elementos orbitales de "MO1" de forma que la 6rbita pase

justo por encima de Madrid (haciendo zoom si es necesario). NOTA: Se sugiere usar 2 ("RAAN"),

recordando el apartado 2; se puede calcular exactamente cuanto hay que modificarlo sin tener que
hacer prueba y error.

7. (Cudl es la modificacion de los elementos orbitales que posibilita que "MO1" pase por encima
de Madrid?

(Si se modifica la excentricidad, cambian las propiedades de repeticion de la traza? ;Sigue
sobrevolando "MO1" Madrid? ;Por qué?

INFORMACION ADICIONAL

Si el alumno ha tenido tiempo de terminar los apartados anteriores, los siguientes apartados son
interesantes de cara a futuros usos de STK, por lo que se recomienda realizarlos.

6. Grabar videos.

Si se ha conseguido el ultimo apartado, grabar un video que muestre como MOI1
(representado con el modelo de los satélites GPS) se aproxima a Madrid y pasa justo por encima. La
forma de hacer esto es, en primer lugar poner el tamafio de la ventana 3D o 2D en su tamafio
original "Restore the window to normal size" & (es como se grabard). Luego, en las propiedades
de la visualizacion 3D o 2D, seleccionar el apartado "Soft VTR" eligiendo "Record every
Animation Time Step", como "File Format" - "AVI Animation (AVI)", pulsar "Apply". A
continuacion aparece una ventana en la que hay que elegir como compresor "Compresor" —>
"Microsoft Video 1". Seleccionar como directorio "Directory" el escritorio y un nombre "File Name
Prefix" adecuado. Una vez se seleccione "Apply", minimizar la ventana de propiedades 3D (no
cerrarla durante la grabacion) y dejando la ventana 3D en su tamafio original pulse "Play" ® en el
display 3D, todo se grabara en el archivo. Para finalizar la grabacion, pulsar "Pause" W en el
display 3D y seleccionar "Off" en el apartado "Soft VTR" y darle de nuevo a "Apply".

7. Planetario 3D.



Una posibilidad de la ventana 3D es usarla de "planetario". Para ello, reiniciar el escenario.
Cerrar la ventana 2D. En el escenario afadir ahora algunos de los planetas del sistema solar, por
ejemplo: La Tierra, Venus, Mercurio, Marte, Urano. También afiadir Pluton considerandolo con
dignidad de planeta. Para ello cerrar "Insert STK Objects", buscar "Insert Default Object" ¢~y
elegir planeta "Insert Planet" ©- | hacer doble click en el objeto planeta que aparece colgado en
"Object Browser" y seleccionar el cuerpo central del que se trata (otra opcidn es insertar un planeta
y copiar/pegar en el "Object Browser"; luego habra que cambiar el cuerpo central uno a uno). En las
propiedades del escenario (doble click sobre €l en "Object Browser"), en 2D Graphics, elegir
"Global Attributes" y seleccionar "Planets-Show Orbits" y desmarcar las dos casillas "Planets -
Show Subplanets Points" y "Planets - Show Subplanet Labels". Cerrar las propiedades del escenario
y posteriormente, en la pantalla 3D, elegir en la barra "3D Graphics Window’s Central Body" € el
Sol. Finalmente, en las propiedades de la pantalla 3D, en "Advanced", elegir "Max Visible
Distance" 1e+020 km. Hacer zoom hacia atras (el boton derecho para acercar/alejar imagen) para
poder contemplar los planetas en la ecliptica; observar la distancia de los planetas exteriores.
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Figura 3: Propiedades 2D.




